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Disclaimer

Certain commercial equipment, instruments, or materials are identified in this paper in order to

facilitate understanding. Such identification does not imply recommendation or endorsement by the

National Institute of Standards and Technology, nor does it imply that the materials or equipment

identified are necessarily the best available for the purpose.
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by
Howard T. Moncarz

Y. Tina Lee
National Institute of Standards and Technology

June, 1991

Abstract

This paper describes the implementation of a prototype

computer programfor translating apparel pattern data between

different file storage formats. The program demonstrates the

feasibility of using a single, standardformat as a mechanismfor
exchanging data between dissimilar pattern design systems. The

program is an implementation of an information model previously

developed at the National Institute ofStandards and Technology

(NIST) for apparel pattern data.

The software was developed as part of an ongoing project at

NIST to incorporate apparel applications into the Standardfor the

Exchange of Product Model Data (STEP), an emerging international

standard. The project is sponsored by the Defense Logistics Agency
and the work is being carried out in cooperation with the Computer
Integrated Manufacturing Committee of the American Apparel

Manufacturers Association (AAMA). In the short term, the project

goal is to develop a neutral dataformatfor exchanging two-

dimensional pattern data between apparel CAD systems. In the longer

term, the goal is to develop an information model that can be used to

encompass the entire apparel life cycle. This achievement would allow

all of the processes involved in the apparel life cycle to share the same
data.

Background

The introduction of computers into the apparel industry has provided the potential for greater

productivity, enhanced quality, and, in particular, faster tum-around time from design to

manufacture. These goals have been achieved to some extent, but a bottle-neck occurs because the

data produced by one manufacturing process (e.g. three-dimensional design) may be incompatible

with that used by another (e.g. two-dimensional pattern making). This means, for example, that

pattern data may not be easily exchanged between different manufacturing processes within the same
factory. Furthermore, the data used and produced by the same manufacturing process implemented
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by two different CAD/CAM systems may also be incompatible. Consequently, there is no standard

way of specifying pattern data that can be communicated unambiguously from one company to

another.

The solution applied to this problem in the apparel industry, as well as in other industries, is

to provide two-way translators for going from one specific data format to another. A separate

translator is required for translation from every format to every other format and back again. Since

there is a multitude of proprietary formats used to represent a pattern within the apparel industry, a

proliferation of translators is the result. If any format is modified, all the translators going to or from
that format must be modified.

An alternative approach is to specify a "neutral" data format as a single standard for data

exchange. This permits each CAD/CAM producer to write only two translators, one going from
their proprietary format to the neutral data format, and the other translator going the reverse direction.

If any company changes its proprietary format, it must only modify its two translators, and no other

company needs to be concerned. This paper describes a pattern data translator that uses this

approach.

In November 1989, the task "Developing a Neutral Data Format for the Representation of 2-

D Pattern Pieces for the Apparel Industry" was assigned to the University of Southwestern Louisiana

(USL) and the National Institute of Standards and Technology (NIST) by the AAMA Computer
Integrated Manufacturing Committee (CIM/COM). As a result, it was recommended to use the

DXF™ file format from AutoDesk, Inc. as a framework to develop a near-term neutral data format

for pattern data. In addition, it was recommended to develop a STEP application model for the

apparel industry as a long-term strategy. (STEP is the abbreviation for Standard for the Exchange of

Ifroduct Model Data, an emerging international standard.) These two conclusions were presented to

CIM/COM at the January, 1990 CIM/COM meeting, and were duly accepted by the members. The
neutral data format for the translator described in this paper is based on the STEP approach. This

was done to demonstrate the feasibility of using STEP in the apparel industry as the long-term

strategy.

The goal of STEP is to develop a complete computer definition of the physical and functional

characteristics of a product throughout that product's life cycle. As a standard, STEP will permit

communications among computer environments, each of which performs various product life cycle

functions. Initially, STEP will be used to exchange information between systems. Eventually, it

will be used to integrate systems, using a shared database as the principal technique to do so.

In addition to the international effort, the U.S. is engaged in a domestic effort called Product

Data Exchange using STEP (PDES). The goal of PDES is to develop the technology needed to

implement the STEP objectives. In 1988 the National PDES Testbed was establish^ at NIST to

support this effort [McLean90]. Also in 1988, several major U.S. technology companies
incorporated as PDES, Inc. with the specific goal of accelerating the development and
implementation of STEP [Furlani90]. Among the projects being undertaken by PDES, Inc. at this

testbed are the development of Application Protocols. An Application Protocol contains the

information that is context sensitive to a particular application domain, and is the method by which
the requirements for that domain are incorporated into STEP [Palmer91].

The ultimate goal for the work being done at NIST for the apparel industry is to develop one
or more Application Protocols for apparel products. The immediate goal is to formulate a

specification for apparel data exchange that borrows as much technology and conventions as possible

from the PDES effort. In line with this immediate goal, an NIST apparel information model for

representing two-dimensional pattern data [Lee90] has been formulated and is represented in the

Express information modeling language. Express is a useful language for representing information

models, and it is being used in the PDES effort to integrate different application domains into the

Page 2



STEP standard. Once the apparel information model has been developed and represented in

Express, it can be used to map a particular two-dimensional pattern to a physical file in the STEP file

format. A STEP physical file contains instances of the various entities defined by the Express

information model.

Design and Implementation

To develop the specification for the neutral format and to demonstrate its usefulness, a

computer program has been developed that will allow the exchange of two-dimensional pattern data

between different industry formats. The translator uses a set of data structures that are derived from
the NIST apparel information model mentioned above. This set of data structures, residing in

computer memory, is referred to as the "working form." Data can be translated back and forth

between different formats, using the working form as an intermediate buffer for that data. (See

Figure 1.)

Figure 1 . Translating between formats A & B: the working

form is used as an intermediate buffer.

The translator described here has been implemented for two industry formats: PN, a

proprietary format from Gerber Garment Technology, Inc.; and DXF, from AutoDesk, Inc., used in

their AutoCAD® product. (Other industry formats exist, but two are enough to illustrate the basic

idea of this translator.) The program also supports a STEP physical file format derived from the

NIST apparel pattern information model.

Each translation, either from industry format to working form or the reverse, is a two step

process. To translate from industry format, the program first reads the data file and translates it to

data structures that are derived from the industry file format. Next, those data structures are

translated to the working form data structures that are derived from the Express model. For the

reverse, to translate to industry format, the working form data structures are first translated to the

data structures based on the industry format being generated. Then, in the second step, those data

structures are used to generate the industry formatted file. (See Figure 2.)
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Figure 2. Two-step translation between the

Working Form and File format A

The file formats currently supported are text files. The translator allows the user to browse,

edit and print these.

Once the data has been converted to working form, functions are available to the user to

operate on that data. These functions include generating a two-dimensional pattern file in a different

format, including the STEP format; displaying the pattern geometry on the screen; and printing the

pattern geometry. (See Figure 3.) Other functions may be added by writing program modules that

use the working form.

Figure 3. Functionality implemented

A graphical representation of a sample pattern is shown in the Appendix, along with the text

file representation of that pattern in each of the three formats supported—PN, DXF, and STEP. The
DXF and STEP file representations of the sample pattern would take up quite a few pages, if they

were shown complete. Therefore, pieces of those files have been omitted in the appendix, indicated
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by the ellipses (...)• Enough of the files are shown to give the reader a good idea of what the files

would look like in their complete representation.

User Interface

The user interacts with the program through a graphics screen designed as a collection of

windows. A window is a rectangular region on the screen that can be thought of as a separate

terminal. Graphics and text can be displayed in the window. The user enters information to a

window through a keyboard and a pointing device called a mouse. A button on the mouse allows the

user to select an item by "clicking" it. Multiple windows can be used at the same time. This allows

the user to look at the display in one window, while working with data in a different window.

When a session is started, the screen appears as shown in Figure 4. A main menu bar is

shown along the top of the screen, and a window with the title, "2D Pattern Translator," is shown in

the upper right region of the screen.

File Edit Parse Generate Special

Figure 4. Initial Screen
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The window is used to display a pattern's geometry, including its grading evolutions (or nests). The
menu bar shows the groups of functions available to the user to operate the program. Any item in

the menu bar may be selected, using the mouse, to reveal a list of functions associated with that item.

Each of these lists is displayed in a vertical column below that item in the menu bar. Figure 5 shows
all of the menu items that may be selected. (During operation, the user can only see one of these

menus at a time.)

File Edit Parse Generate Special

New
Open...

Undo PN...

DXF...

STEP...

PN...

DXF...

STEP...

Display Pattern

Print Pattern...

Cut
Close

Save

Save As...

Revert

uopy

Paste

Clear

Select All

Page Setup...

Print...

Show Clipboard

Quit

Figure 5. Menu bar with all Items pulled down

The first two menus in the menu bar. File and Edit, are used to create and edit the text files

that are read or generated by the program. When the user clicks the "Open" item in the File menu, a

file requestor appears. A file requestor is a special type of window that allows the user to specify the

name of a file to select. The elhpses (...) after "Open" in the menu item indicate that additional

information will be required after this item is selected, before any action is invoked. In this case, that

additional information is prompted by the file requestor. Once the file has been retrieved, a text

window appears, and the text representation of the file is displayed in it. Multiple text windows can

be opened. Each window permits a view into a file and allows the user to modify that file, using

functions in the Edit menu. The items in the File menu, "Close" through "Revert," control whether

the changes are stored permanently in the file or discarded.

The third menu. Parse, asks the user what file format to read, and then requests that the user

enter the name of a file. The file is expected to be in the format selected. The program then attempts

to read the file in the specified format and translate it to working form data structures in memory. If

the file is successfully read and translated, a nest of the pattern will be displayed in the 2D Pattern

Translator window. If there are errors, the user will be alerted, and error messages will be saved in

an error file. The error file will appear automatically for the user to browse. The user can then call

up another window to look at the erroneous data file with the corresponding error window indicating
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where and what the errors are. The data file can then be modified on-line and parsed again if

desired.

The fourth menu, Generate, is the reverse of the Parse menu. This menu allows the user to

translate the working form to one of the supported file formats.

The last menu. Special, contains functions that operate on the working form. Currently, a

display function for refreshing the screen's display of the pattern piece and a print function for

transferring that display to a printer are supported.

Discussion

The development of the Apparel STEP Translator Program was part of an ongoing effort to

support the apparel industry in the development of standards for the apparel manufacturing life cycle.

The AAMA has decided to use the AutoCAD DXF format as a starting point for an interim pattern

data exchange standard, based on a report from the University of Southwestern Louisiana [USL90].

This standard will be a short term solution for exchanging pattern data. (As mentioned previously,

STEP will be used as the long term solution.) Conventions (permitted within the DXF format) will

be defmed in the AAMA interim standard to support pattern data. The translator currently supports

the DXF standard with a preliminary version of the conventions that are now being established. The
translator will be modified to support the DXF standard as it evolves, and will be available to all

parties involved in developing the standard. This will be useful in the evaluation of the standard and

should help in its development.

One type of problem that miust be addressed for any standard for pattern data exchange
concerns the inconsistencies that exist among the different industry formats. In some cases, an entity

defined in one industry format will have no analogous entity in another format. For example, there

is one entity in the Gerber PN format called the "special piece number." This entity is used within a

Gerber system, but has no relevance to systems made by other companies. Continued development
of the translator program can uncover these types of problems. However, each company that has

developed its own format is in the best position to implement that format as a module in the translator

program. Such an exercise would be valuable in discovering potential problems with the standard

being developed. Consequently, it is in everyone's interest to have the active support of as many
companies as possible in developing the standard. Furthermore, development of commercial-grade

applications using the standard (such as translator programs) is beyond the scope of NIST work and
must be done by commercial parties.

Using STEP technology can leverage the apparel industry's efforts in three ways. The first

is that modifications made to the apparel information model can bo, easily propagated to computer
programs developed to use that model. This is because the information model itself is represented as

data. The second advantage is that once the apparel model is incorporated into the STEP
framework, all generic applications that have been developed for STFP models are available to be

used with the apparel model. For example, the STEP file produced may be browsed and edited

using programs developed for a generic STEP model. Finally, the third advantage is that using

STEP technology will ensure that the standards developed by the U.S. apparel industry are

consistent with international standards. This will encourage acceptance for U.S.products abroad.

The NIST PDES Toolkit [Clark90] is an example of STEP technology that is useful to any
industry using STEP. This Toolldt is a set of software tools that is helpful for building applications

that use STEP. The PDES Toolkit has been used to build a number of applications in other

industries, but it has not yet been used in the apparel industry. At the time this project was begun.
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the PDES Toolkit had not been ported to the translator's computer platform. The tools are now
being ported to this environment by staff from the National PDES Testbed.

The Apparel STEP Translator Program that has been implemented thus far has been

developed from scratch, without the aid of the PDES Toolkit. The architecture of this program is

similar to that which would be implemented using the toolkit, with some notable differences. The
most important difference is that, for the current program, the information model is embedded in the

system, rather than read in as data. This makes the program more difficult to maintain if the

information model is modified. Furthermore, the features available to the user are those programmed
for this particular application, and do not include any generic PDES functions that would be available

if the toolkit were used. Once the PDES Toolkit has been ported to the translator's computer
environment, the toolkit will be integrated into this computer program, and the benefits mentioned

above can be accomplished.

Concluding Remarks

The computer program developed demonstrates the feasibility of using STEP technology in

the apparel industry. The information model used was not intended to be a standard. It was
developed for demonstration purposes. It did not include the consensus process necessary for

developing a standard.

In addition to demonstration purposes, the flexibility of the program enables it to be used as a

tool for standards development. The authors hope that this tool, and others like it, will encourage the

use of STEP in the apparel industry.

NIST is now moving toward a more formal and active standards-development effort in the

apparel PDES project. Under the Defense Logistics Agency's sponsorship, NIST will continue to

work with AAMA to extend STEP to include apparel product data. The work will also be carried out

with support from, and in cooperation with, standards organizations, the apparel manufacturing

industry, and academia.
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Appendix Sample Pattern Data

Nest of
and

"Pattern Piece 1004" for
four graded sizes {S

,

12
base
, 16,

size
22 )

(14)
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99990501
1004 10 BACK CUT 1

99990100
299 23621624236216242362171323551752234317942314184222881876
225 2288187623371952236920232391209224102190
281 241021902599216027912129

4 2791212927912129301920933242205934862024
5 348620243486202436711999386919763940197239921973

220 3992197339921973411719834307201045092037474220574938206951402077

221 5140207751491624
10 514916245149162451401171

222 51401171493811794742119145091211430712384117126539921275
223 399212753992127539401276386912723671124934861224
17 3486122434861224324211893019115527911119
18 27911119279111192599108824101058

282 2410105823911156236912252337129622881372
224 228813722314140623431454235514962362153523621624
lis 2636177341561776

99990200
14 61214 1622
299N -517 -650 -600 -683
225N -567 317 -650 300 -600 -633 317
281N -633 633 -650 650 -600 600 -467 467

4 367 550 567
5 367 550 567

220 367 550 567
22 IN 367 550 567
10

222N -367 -550 -567
223 -367 -550 -567
17 -367 -550 -567
18 -367 -550 -567

282N -633 -633 -650 -650 -600 -600 -467 -467
224N -567 -317 -650 -300 -600 -633 -317
IIN

99990600

Gerber PN file for Pattern Piece 1004

Page 1
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/* The file structure of this APDES STEP file is
based on the Document 284 of ISO TC184/SC4/WG1-
Oct . 21 , 1988. This file has been presented in
a line-oriented or record-oriented manner in
order to aid readability. Spaces have also been
added to aid readability. Note that an ordinary
STEP file is not aligned in this manner, but is
instead a continuous stream of characters.

*/

STEP;

HEADER;
FILE_IDENTIFICATION

(

’ BACK CUT 1
'

,

'19900816.091124',
('Tina Lee & Howard Moncarz, (301) 975-3550 or 3350'),
('National Institute of Standards and Technology,
Factory Automation Systems Division'),

'APIM STEP VERSICN 1.0',
'Preprocessor Version 1.0',
'Criginating System - Gerber AM-5

' )

;

FILE_DESCRIPTIGN

(

'This file contains a sample APDES file');
IMP_LEVEL ('1.0');
ENDSEC;

DATA;
@299=TWD_D_CDDRDINATE (23.62,16.24);
@22 5=TWG_D_CDDRD INATE (22.88,18.76);
@2 81=TWD_D_CGGRDINATE (24 .10,21. 90) ;

@4=TWD_D_CCCRDINATE (27 . 91,21.29)

;

@ 1 1=TWC_D_CDGRD INATE (26.36,17.73);
@ 100 1=TWD_D_CDDRD INATE (23 .62,17. 13)

;

@1002=TWG_D_CGDRDINATE (23 .55, 17.52) ;

@1003=TWG_D_CCGRDINATE (23 . 43, 17.94)

;

@1004=TWG_D_CDCRD INATE (23 .14,18.42);
@1037=TWG_D_CDDRDINATE (41 .56, 17.76)

;

@1041=GRADE_PCINTS (#299, #225, #281, #4, . . . )

;

@1042=MARK_FEATURE ( .NCTCH. , #299)

;

@1043=MARK_FEATURE ( .NCTCH. , #4)

;

Apparel STEP file for Pattern Piece 1004

Note: For brevity, this is only a partial file. Enough of the
file is shown to give the reader an idea of its format. The
ellipses (...) indicate where portions of the file are omitted.
The file is continued on the next page.
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@1064=ORIENTATION CONSTRAINT ( . STRIPE
.

, LINE (#11, #1037 ) )

;

@1050=COMPOSITE_CURVE_FEATURE ( . BOUNDARY_CUT
.

,

(#2 9 9, #1001, #1002, #1003, #1004, #22 5) ) ;

@1040=BASE_PATTERN('1004', ’ BACK CUT 1',

WOMENS_PATTERN_SIZE (14, .REGULAR.
)

,

#1041,
(#1042, #1043, . . . , #10 64, #1050, ...));

01O66=GRADE_DATA(#299, .NO_SMOOTH.

,

(TWO_D_DELTA_COORDINATE (-0.0517,0.0000),
TWO_D_DELTA_COORDINATE (-0.0650,0.0000),
TWO_D_DELTA_COORDINATE (-0.0600,0.0000),
TWO_D_DELTA_COORD INATE (-0.0683,0.0000)));

@1067=GRADE_DATA(#225, . NO_SMOOTH
.

,

(TWO_D_DELTA_COORD INATE (-0 . 0567, 0 . 0317)

,

TWO_D_DELTA_COORDINATE (-0 .0650,0 . 0300) ,

TWO_D_DELTA_COORD INATE (-0 .0600, 0 . 0300)

,

TWO D DELTA COORDINATE (-0.0633,0.0317)));

@1065=GRADE_RULE ( (WOMENS_PATTERN_SIZE (6, .REGULAR. )

,

WOMENS_PATTERN_SIZE (12, .REGULAR.
)

,

WOMENS_PATTERN_SIZE (14, .REGULAR. )

,

WOMENS_PATTERN_SIZE (16, .REGULAR.) ,

WOMENS_PATTERN_SIZE (22, .REGULAR. ) ) ,

(#1066, ...));

@1039=PATTERN_PIECE ( . INCH. , .BASIC. , #1040, #1065)

;

@1038=TWO_D_PATTERN (

'
garment name

'

,

' description
' ,

(#1039, ...));

END SEC;

ENDSTEP;

Apparel STEP file for Pattern Piece 1004 (continued)



8 8

0 0 BOUNDCUT
SECTION 10 66

2 1.00000 1

HEADER 20 0

0 1.00000 VERTEX
ENDSEC 40 8

0 0.25000 BOUNDCUT
SECTION 1 10

2 FILENAME

:

23 . 62000
TABLES pnl004 . dxf 20

0 . . . 16.24000
ENDSEC 0 0

0 ENDBLK VERTEX
SECTION 0 8

2 ENDSEC BOUNDCUT
BLOCKS 0 10

0 SECTION 23 . 62000
BLOCK 2 20

8 ENTITIES 17 . 13000
0 0 • • •

2 POINT 0

PIECEINFO 8 SEQEND
70 NOTCH 0

0 10 POLYLINE
10 23.62000 • • •

0.00000 20 0

20 16.24000 ENDSEC
0 . 00000 • • • 0

0 0 EOF
TEXT POLYLINE

AutoCAD DXF file for Pattern Piece 1004

Note: For brevity, this is only a partial file. Enough of the
file is shown to give the reader an idea of its format. The
ellipses (...) indicate where portions of the file are omitted.
The three columns of this file actually represent separate
pages

.
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